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INTRODUCTION

First things first, welcome to the Unity Engine! Whether you're new to game development
or a seasoned pro looking into new technology, the Unity Engine has a lot to offer. Avail-
able for Mac, Linux, and Windows, the engine can create games that can be deployed on
just about any platform available, from the Web, to the Xbox and PlayStation (if you are a
licensed developer), to mobile devices like smart phones and tablets. The easy interface,
friendly development environment, and wide-ranging support of all popular gaming plat-
forms make it a great choice for the student, indie, and larger developer team.

Unity’s clients include such names as Ubisoft, Disney, and Electronic Arts, but the engine
is also highly utilized by small independent studios, hobbyists, students, and even compa-
nies outside of the gaming industry for medical simulations and architectural walk-
throughs. Whatever the end goal, Unity allows anyone, regardless of background, to
create fun, interesting, and interactive content. Let’s get started.

WHAT WiLL BE Coverep (AND WHAT WON’T)

This book is an introductory look into the engine. It explains what Unity has to offer and
gives a few pointers on how to best use its capabilities for whatever it is you want to do. If
you're a hobbyist or student, you'll probably want to start reading from the beginning and
follow along with the example project. If you're using this book as a tool to evaluate
whether the engine is right for you, you're probably best skipping around to the relevant
chapters.

xiii
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If you start from the beginning, you’ll learn all the important interface commands, how to
set up and organize your project, and all the basics of getting a 3D game up and running,
from character importation to scripting to audio. After completing the sample project,
you'll have all the skills necessary to go out and make your own games.

What this book isn’t is a crash course in the Unified Theory of Game Development and
Design. By that, I mean you won’t be granted some mystical information or mad skills for
everything there is to know in design, programming, art, or sound. Each topic covered
(such as game design) does include some basic theory and information—enough to get
you going on a working vocabulary and introductory concepts. This book won’t make
you a star designer or a world-class programmer, however. That requires years of study
and practice.

If, after reading, you do find yourself interested in a particular field, check out Appendix D,
“Resources and References,” for pointers on where to get more information. Think of this
as a sampler course stretching across multiple cuisines, not an in-depth exploration of one
particular food type. More advanced and singular topics such as network integration and
discussions on Unity’s shader language are also not covered.

INTENDED AUDIENCE

So, who exactly is this book for, anyway? If you fall into any of the following categories,
you've come to the right place:

B A solo developer or generalist looking for some well-rounded information on
utilizing the engine

B A developer looking to evaluate the engine for use in future projects
B A hobbyist needing a how-to guide about some specific areas

B A student (or prospective student) wanting to know whether game development is
right for you

B Anyone looking to build a game portfolio using an affordable (or in some cases free)
professional engine

As stated, all the game development sections cover some basic background knowledge and
go over a few key terms. However, the text does assume some knowledge or skills in a few
areas if you plan to work away from the sample project. For example, creation of 3D art
assets and how to use a 3D modeling package are not covered. All the required models
used in the text (and then some) are included on the companion website (more on that
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in a moment), but their creation is not described. If you stick to the sample project while
reading the book, you won'’t really need any outside knowledge or skills (although any
game development information is a plus). If you plan to work on your own project from
the start using this book as a guide, then you’ll need to educate yourself in the other areas
of development or find other places and people to provide art and code. If creating models
and animations isn’t your thing, the Unity Store has a wide range of assets for free and for
sale, and there are many communities out there who can help you develop your own.

THE Book’s STRUCTURE

The information in the book is organized into five parts, each covering a general aspect of
game development. Within each part, chapters are devoted to each single concept, such as
one chapter for Al development and another for particle effects. If you need help on a spe-
cific area of Unity, go to the corresponding chapter or use the handy index. The appen-
dixes include a list of common and helpful shortcut keys, a rundown of the most-used
classes, and exercises for you to complete if you want a few pointers on what to do once
you finish reading. A compiled glossary for all keywords introduced in the text is also con-
tained there.

I've tried to make learning the engine a little more straightforward by using some general
formatting guidelines. Steps for you to complete in the engine always appear in numbered
lists. If you see such lists coming up on the page, you should open Unity to follow along.

Links between steps in a folder chain or nested menu are marked with the > symbol. So
the line “My Documents > My Unity Project” would mean to open the My Documents
folder and then open the folder My Unity Project contained within it. Pretty straightfor-
ward. Code to write in the engine is blocked off in its own formatting, as shown here:

//1'ma comment
Update()
{
print("Hello World");
}

Finally, some extra information is included in the form of sidebars. These mostly cover
more advanced technical data or engine specs and aren’t required knowledge for using
the engine on a day-to-day basis. They do tend to be helpful, however. Also be mindful
of tips, notes, and warnings scattered throughout the text. These are often important, con-
taining information about common pitfalls and helping to stave off potentially hard-to-fix
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disasters. If time was taken to graphically embellish something, it’s probably worth a sec-
ond look.

INSTALLATION INSTRUCTIONS

Installing Unity is quick and painless and technically requires an Internet connection.
Unity comes in two flavors, Unity Basic, which is free, and Unity Pro. Both are regularly
updated by developers. Although you won’t need the Internet again after activation, it is
advisable to have a connection if only for the patch updates and fixes.

The Unity Engine

First up, install Unity. You can download Unity from the Unity Technologies website:
unity3d.com/. From the Download menu, click on either the Mac or Windows version
button, whichever is right for you. (This book uses the Windows version for all its
examples.) You can choose to download the free Unity Basic version directly or get a
Unity Pro license trial version, which is free for 30 days. It doesn’t really matter as far as
the book is concerned, but it can be fun to see what goodies the Pro version includes.

Note that Unity has grown to include many features and these features require space. The
installer is about 1 GB. The download time will depend on your Internet connection. A
fast broadband connection can usually handle the transfer in a few minutes.

Once the download is complete, run the UnitySetup-###.exe file, accept the terms of
agreement, and follow the onscreen command prompts. When you get to the Choose
Components screen, shown in Figure 1.1, make sure the Example Project checkbox is
selected. You'll probably also want to select the Unity Development Web Player checkbox
as well, in case you ever want to publish your games to the Internet. In addition, consider
selecting the MonoDevelop checkbox even if you have your own development environ-
ment because the bundled version of the MonoDevelop editor has some specialized fea-
tures that are hard to get in other editors. If you change your mind later you can re-run
the installer to add or remove components. Then click Next and finish the installation.
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Choose Components
Choose which Features of Unity 4,3.4F1 vou want to install, Q

Check the components you want to install and uncheck the components wou don't want ko
install. Click Mext ko continue.,

Select components to inskall: Unity

Example Project

Inity Development Web Player
MonoDevelop

Space required: 4.7GE

Mullsaft Install System w2, 46-Unicode

< Back ][ Mexk = ] [ Cancel

Figure 1.1
All components are selected by default, requiring nearly 5 GB of space.

Source: Unity Technologies.

Use the default install path or select your own, and then click Install. Unity takes nearly
5 GB of install space, so make sure your selected destination can handle this plus any
other add-ons or projects you want to use later. Follow the other onscreen instructions
to complete the install.

After the install has finished, Unity will prompt you to register your copy. For the free
version and trial Pro, this is easy. Select the Internet registration version (if available)
and fill out the form on the website the engine takes you to—usually it’s just your name
and email address. After this, Unity is yours to use.

Once the engine has finished installing, it’s time to move on to the contents of the com-
panion website.
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Using the Companion Website

To access the book’s companion website, visit www.cengageptr.com/downloads, and type
the name of this book in the Search field. The companion website is divided into a few
main sections:

B Chapters: This folder contains subfolders for each chapter in the book, whenever
they require the use of files or assets. You can either copy the entire Chapters folder
to your hard drive now or just grab the individual files when you need them. The text
always specifies when a file is needed and where to grab it.

B Design Documents: This folder houses all the basic information for the sample
project discussed in the text, a game called Widget. When the text says to view the
Design Docs, they're located in here.

B Shader Test: A sample project detailing and comparing the basic shaders side-
by-side that are available in Unity. If you’re not sure which shader to use or how
some shaders may interact in a specific lighting rig, modify and use this file as
needed.

® Final Project Files: Unlike the Chapters folder, which houses all the individual files
as they come up in the text, the Final Project Files folder is a complete Unity project
for the Widget game. If you ever get stuck or want to see how something fits together
later, you can always check out the game here. Extra assets such as more models,
textures, and UI elements are also included here for any further expansion you may
want to pursue.

Optional Installs

Between Unity and the contents of the companion website, you can complete every exer-
cise in this book and get the sample project up and running. However, you may find your-
self wanting to tweak a graphic or texture here or there, or maybe even sculpt a new
model to import. Many free software packages are described both in the text where appro-
priate and in Appendix D. If you don’t already have something installed on your com-
puter, check the appendix for information and a link.

Unity includes MonoDevelop, a free code editor to use for scripting, but you can use your
own favorite coding environment if desired. Chapter 6, “Scripting in Unity,” covers com-
patible ones in more detail, and Appendix D also provides links where appropriate.
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PARTING WORDS oF WisDOoM

You probably have tons of great game ideas floating around in your head. Maybe you've
even started working on one, the big one that'll net you that dream job or needed raise.
Maybe you have built some small projects in the past and want to use a comprehensive
engine rather than doing everything yourself. Or perhaps you've started two games, or
three, or...you get the picture. Working on making your snippets of ideas and musings
into playable games is great—but how many have you actually finished? Making a game
is a huge commitment, fraught with tons of unforeseen setbacks, design changes, and soft-
ware explosions, all for a tiny little bundle of ideas that you hope others will love as much
as you do. It’s far too easy once the first dragon rears its head to stop working, take an
extended break, and never return to the field to try again. It’s not procrastination, you
tell others, it’s just a short time away to rest your eyes, to let your ideas simmer free of
worry. The short break becomes a week, and then a month, and years roll by as your little
unfinished game collects dust in the corner.

Tackling the problems in game development is hard work. Sometimes you follow a trail of
ideas and discover barriers that need to be climbed, worked around, or pushed through.
Other times you need to admit that the idea was wrong, it didn’t work out as expected, or
it’s just plain un-fun. Don’t walk away from the whole project and leave the game unfin-
ished. Try something else, even if you're unsure where this new path will take you. Maybe
it won’t work out, but maybe it'll be the solution to a whole host of problems. Try, make
mistakes, learn, and try again. Be willing to make mistakes and learn from them, and keep
tighting your way through until the game is complete. No game is perfect and defect-free,
but you can reach the point where you can say it is complete.

Finish that game, and then finish another. It doesn’t matter if you think they’re horrible,
terrible piles of swill you'd be embarrassed to show your own mother. Show her anyway.
They may suck, or they may not. Either way, analyze what you did that worked and didn’t
work. The process is as much about learning as it is about creating, and no one ever
excelled by stopping halfway. If you get discouraged, it is okay to take a break, but always,
always come back to it in the end. Support from friends can help greatly in this—involve
some of your buddies in rounds of routine play tests. Make a party of it. Celebrate what
you do and remember to have fun. If you're not having fun, you're probably not making
fun!
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One late night, as we were pushing to finish a game, I was sitting in the cafeteria, dining
with co-workers on a large tray of studio-provided “mystery nuggets” for dinner. Some-
one said, “It is eight o’clock at night and I'm still at work on this crazy project that never
seems to end. I could be spending time on so many other things. Will you remind me why
we are still here?” Another co-worker spoke up, and his reply was heartfelt: “Because we
love it. No matter how many problems we encounter and difficulties we overcome, we
love it. We love creating these amazing games that entertain millions of people. We are
artisans, passionate about doing our best on every task. We are not just working late and
eating deep-fried mystery nuggets; we are building a game to inspire, to entertain, and to
give the world something that they may savor and enjoy. Just like the mystery nuggets,
most people will have no idea what is inside, but when they play the game they can be
entertained and enjoy a moment of life. That makes the difficulties worthwhile.”

Be passionate. Development is work and sometimes it is difficult. Sometimes it is painful.
Sometimes you will be disappointed and unsatistied with the results. Just keep pushing,
sharing your passion, and doing your best work. Game development is a powerful career.
We create new worlds, teach, entertain, and inspire. We start with a blank file and finish
with a product that can change the world. Be a game developer.



PART |

IN THE BEGINNING ...

As with any new endeavor, it’s usually best to start somewhere in the beginning. And
before you even start, it’s best to lay out your tools and get your ideas in order. You
wouldn’t attempt (I hope) to build a house without a blueprint, and games are no differ-
ent. The best game ideas in the world won’t get you very far unless you have the knowl-
edge, skills, and discipline to see them fully realized and implemented.

Before Unity, making a game from scratch for the newbie game designer was a rather
daunting process. Engines, especially free ones, weren’t terribly easy to come across, and
those that were often suffered from poor execution or lack of documentation. Now with
Unity, you can quickly get your ideas in motion, even if you lack a strong art or program-
ming background.

In this part, you'll learn the basics of the engine and its interface, as well as how to refine
your game idea from the get-go, hopefully saving you some time and energy later in the
process.
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CHAPTER 1

AN OVERVIEW OF THE
UNITY ENGINE

Unity is a powerful integrated game engine and editor, enabling you to quickly and effi-
ciently create objects, import external assets, and link them all together with code. The
editor is visually driven and built around the principles that you can do everything with
a simple drag-and-drop motion—even connect scripts, assign variables, or create compli-
cated multi-part assets. Unity also boasts an integrated scripting environment, built-in
networking capabilities, and the ability to build and deploy for multiple platforms. All of
this is wrapped up in a simple, intuitive, and customizable workspace.

GETTING ACQUAINTED WITH THE INTERFACE

Before diving headfirst into making your first game with Unity, it’s worth the time to first
take a quick look at how to get around in the editor. Unity may look a bit daunting when
you first open it, but you'll find that you can easily master its basics in a day.

If you haven’t done so already, open Unity. Choose Start > Programs > Unity (C:\Program
Files\Unity\Editor\Unity.exe) or click the desktop icon if you created one. Then load the
Ch1_TestFile.unity file located on this book’s companion website to follow along. Figure
1.1 shows the Unity environment.
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Figure 1.1

The Unity environment after you load the Chapter 1 sample. By the end of the chapter, you will understand all the
parts you see on the screen.

Source: Unity Technologies.

Note

If you installed one of the demos with the engine, a scene from the demo will load by default until you either
load a different scene or create a new one.

The editor’s default layout is broken into a series of different panes and tabbed windows
called views. Each view details a specific aspect of the editor and allows you to perform
different functions when working on your game. If you’ve used a 3D modeling program
or other game editor in the past, you may find some of this familiar.
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You can rearrange the views to suit your preferences. Views can be repositioned, resized,
and even broken off to their own separate windows. Several presets can be found in the
menu under Window > Layouts. Depending on the size of your monitor, you might prefer
the Wide layout or the Tall layout, or you might decide to create your own. Don’t worry
about getting the settings wrong; you can always reset the Unity views back to the default
layout by selecting Window > Layouts > Revert Factory Settings.

The Project View

All of a game’s files—scripts, objects, scenes, anything and everything—are organized into
a Project folder, each of which contains an Assets folder. The Assets folder houses every-
thing you've created or imported to include in your game—meshes, textures, scripts, cam-
eras, levels...everything. (See Figure 1.2.) The Project View panel displays this Project
folder and the incorporated Assets folder.

Asset preview icons

Tab name Search bar Window options
f X
B9 Project | & ls
Quick —t+ create - G Y| & | %
Creation menu Assets
i <.
‘rﬁ _TestFiles Ch3_TestFi.. Standard A..

Asset tree —f— &5 _TestFiles
v 63 standard Assets
i Blob-Shadow

‘|[—(_J_

Icon Scale slider

Figure 1.2
The Project view.

Source: Unity Technologies.
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The Project view displays everything included in the game’s Assets directly, exactly how
they are organized and arranged on your computer’s hard drive. If you are unsure, how-
ever, of where these files are located (or if you ever forget), you can simply right-click any
selected asset in the Project view and select Show in Explorer.

Arrows next to folders indicate nested layers. Clicking any one of these will expand that
folder’s contents. You can also Shift-click an arrow to fully expand or contract its con-
tents. Moving and organizing files into different folders can be achieved in the Project
view with a simple click and drag.

Caution

Be careful about moving your asset files around outside the Unity Editor. In fact, avoid it at all costs. If you
need to reorganize or move an asset, do it from within the Project view. Not doing so could break or remove
any metadata or links associated with that asset, possibly breaking your game in the process.

When you select an asset folder or a Favorites folder, the preview icons update to show
you the folder’s contents. Use the Icon Scale slider to change the size of the icons. If you
slide the Icon Scale slider all the way to the left, the display will change from icons to a list.

Each type of object listed also has its own descriptive icon or thumbnail, making it easy to
quickly scan the contents. Many assets, like directories, source code, and general data files,
use a standard icon. Other assets, like Photoshop images, 3D models, textures, and mate-
rials, display a thumbnail preview of the asset in the file.

The Search bar enables you to quickly find assets directly by name. The three buttons on
the right side of the Search bar let you search by type, search by tag, and save the search as
a favorite. On a small project, you can usually remember where all your assets are located.
But when a project contains hundreds or even thousands of assets, using the search tool is
the easiest way to find what you need. The Project view’s list will dynamically update after
each letter you type, allowing for easier browsing if you don’t quite remember the asset’s
exact name.

You can open and edit files directly from within the Project view. If you find you need to
tweak or correct something in any file (like a Photoshop file), simply double-click the file
to open it in its default editor. Save the file normally to have Unity import it back into
your project.

Sometimes you’ll find it necessary to make new assets or objects that aren’t contained
already in your Project view. Unity makes this easy from within this view—simply click
the Quick Creation menu to bring up the available options. This shortcut menu is located
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right beneath the Project tab. From here, you can make new folders, empty script files, or
other game-specific objects without having to leave the editor. Right-clicking in the Project
view itself will also give you a link to the Quick Creation menu and its options, placing the
new file at your current location in the file tree.

Tip

To rename any file or folder, you can click twice slowly on the name (not a normal fast double-click) or select
the desired file and press the F2 key. Then start typing. Press Enter when you are done renaming your file.

Right-clicking in the Project view will bring up a few advanced options, including asset
importation, syncing with external project controllers, and asset package manipulation.
See Figure 1.3. These are covered in more depth in later chapters.
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Figure 1.3

The right-click menu and Import Package menu options.

Source: Unity Technologies.
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All tabbed windows have a Windows Options drop-down list, allowing you to maximize
the selected view, close the viewed tab, or add another tab view to the window. Click the
icon to bring up the available options.

The Hierarchy View

Whereas the Project view lists all the objects and files available in your game, the Hierar-
chy view lists just the ones you're actually using in the current scene. The objects in the
scene are listed alphabetically. As you add or remove objects from your game, the Hierar-
chy view will update with each change. Selecting an object in the Hierarchy view and
pressing the Delete key (or right-clicking and selecting Delete) will remove the object
from your current scene in the game, but not from the project’s Assets folder. Figure 1.4
shows the game’s current contents as an example.

= Hierarchy |
Create | (Erall
Directional light
Main Camera
v

Cube
Plane
Sphere

Figure 1.4
The Hierarchy view, showing the game scene’s current contents.

Source: Unity Technologies.

Each instance (a copy or occurrence) of an asset will be listed individually, so good naming
conventions are especially important. If you have 30 instances of an object all named Cube,
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you may have trouble finding the one you want later. You can rename any object in the
Hierarchy view independently of its actual filename in the Project view. A simple mesh
named Cube in your Project view can then be instanced and renamed in the Hierarchy view
to anything you want, like Crate, Box, or Mystery Pickup23, making it easier to find and use
later. Note that this will not update the filename of the actual object in the Project view or on
your computer. To do that, you must change the name from within the Project view.

Parenting objects together in the Hierarchy view can also help with organization and
make editing your game easier. When you parent objects together, you are basically link-
ing a collection of unrelated objects together in a group under a single object, the parent.
All the objects under this parent are called its children, or child objects. See Figure 1.5.

= Hierarchy
Create = | (Al

Unparented objects —{{ Directional light
Main Cammera

Parent object —=

Cube
Child objects — Plane
Sphere

Figure 1.5
Parented and unparented objects.

Source: Unity Technologies.

In the example, the parent object is an asset called Primitives, under which three child
objects are located: Sphere, Cube, and Plane. Clicking the arrow next to Primitives will
expand or collapse the group, much like with the folders in the Project view. However,
parenting gives you one other important benefit besides a speedy way to group like objects
together: Moving or manipulating the parent object will in turn do the same to all the chil-
dren underneath it. They are said to inherit the parent’s data. The child objects can still be
edited independently of each other and the parent object, giving you more control.

If you're still uncertain about parenting, think of a normal person’s body. An arm is par-
ented to the torso, and a hand is parented to the end of the arm. Moving the torso forward
(the parent) will move the arm with it, which will in turn move the hand (the two children).
However, you can move and rotate the hand around without moving the torso or the arm.

Using parented objects can make moving large numbers of objects around much easier
and more precise, and should be used whenever possible. A few more advanced concepts
of parenting will be covered in Chapter 4, “Building Your Environment: Importing Basic
Custom Assets” and Chapter 6, “Scripting in Unity.”





